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1. Introduction 

( Note: Go to Section 2.5 for a Quick Tour of  the major features and functions of  CTPRO. \ 

1.1 BACKGROUND 

CTPRO was developed by Maum Engineering Inc. under sponsorship of the joint-industry project DEA-67 
To Develop and Evaluate Coiled-Tubing andslim-Hole Techlogy .  CTPRO is written in Visual Basic 5 
for use with IBMcompatible computers. It runs in Microsofi Windows 95 or later versions. 

A great vanety of j o b - p l d i  and field problems for CT applications and slim-hole operations can be solved 
by implementing the user-friendly p r o m  developed under the DEA-67 project. Initially, p r o p s  were 
originally conceived and developed as "stand-alone" pro-er;rms that require separate user input into each 

-a. ..-.-application. Each p r o m  is &elf a powerful engmeering tool. However, a job design developed with one 
pcogram may not be optimum when another aspea of engineering design is considered. 

IPan enginem planning a field operation with CT changes a design parameter in one area to overcome a 
, . .. .- --. - - .-,-- ---,xpecific problem (for example, increasing CT wall thicloless to increase penetration limit), other p ropms  

must be m and rerun to ensure that new problems are not created (for example, exceeding pressure limits 

the surface). Inputting data and modifications to the planned operation into each separate program can be - - e consuming, and may in some cases limit an engineer's ability to optimize the operation. 

Concept - 
z ", . 

- ': 
.* 

, 
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Chapter I .  Introduction 

The W R O  Coiled-Tubmg Profgsional Package is designed to combine all CT software applications into 
an integrated soflware platform. This package streamlimes a j o b  design and will allow real-time intervention 
in the field. User-friendliness for engineers and field personnel is increased through input screens designed 
for specific field operations. Critical parameters are calculated and compared simultaneously to provide rapid 
analysis of the complete job design. 

Design of the CTPRO package is centered around five basic componentsfmodules (see graphic on previous 

1. The Data Manager is used to store, access, and modify CT operations reference data which will then 
be available for use in job planning. These database groups include CT mechanical properties, available 
equipment (rigs, CT strings, spools, BHAs, downhole tools, etc.), wellbore surveys, casing progams, 
and other en,+eering references such as properties of workover fluids. Real-time data are also accessed 
and stored through data acquisition interfaces, as appropriate. 

The Operations Model is the standard job-planning tml in the CTPRO package. This analysis module 
is used for a complete multiparameter analysis for which the engineer or operator specifies the job to be 
performed, the equipment to be used, the wellbore environment and the mechanical/hydraulideconomic 
limits to be applied. Output from the analysis includes comparative plots of all critical parameters 
including drag loads. buckling limits, triaxial s&eses, pressures along the circulation path, surface loads, 
and other parameters. 

The Engineering Models can be accessed for detailed engineering studies of mechanical/hydraulic 
behavior and sensitivity analyses of critical parameters. More detailed results are provided within each 
Engheerhg Model than are given for the standard Operations Model output. These modules are based 
on individual ME1 CT progams. 

The Output interface is accessed after the calculations are performed. The output may be viewed in 
a variety of formats (graphs, tables, schedules), printed, saved, or exported. 

+ * 5 .  The Operations Optimization Pbtfonn in- the other elements of CTPRO. In later versions of 
the program, this platform will also include logic for an expert system tha  will automatically cycle 
through the CT software modules ensuring that all preset parametric limits are satisfied. CTPRO can 
then be utilized to quickly optimize planning of CT jobs. 

A similar design concept for data sharing between different engineering programs has already been 
successfully applied to many ME1 programs in the Horizontal Well Technology project software suite. The 
GALAXY database allows these programs to share input data with one another and wii5 third-party databases 

(Landmark's DIMS and others). CTPRO will take an important step beyond GALAXY by using a single 
central platform for input and output (making data sharing automztic) and converting the previously separate 
pro-crams into modules (i.e., subroutines) of the central platfom. 

1.2 FEATURES OF CTPRO 

CTPRO 1 is a major new release in the leading-edge suite of coiled-tubing (CT) des ig  software developed 
by MEI. The "look and feel" of the program is user-friendly and intuitive. CTPRO runs in the Windows 95 

environment, and tabs and icons are used to quickly navigate through the pro_pm. Database management 
is simple. logically designed, and convenient. 
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Chapter I .  Introduction 

Another significant feature is a complete Help system. Descriptions and imiructio~ are provided for every 
input and output screen by clicking or [FI]. The Help system is also context sensitive to allow intuitive 

navigation by pointing and clicking the mouse on the area of the screen where the user's question originates. 

CT'F'RO runs in the Microsoft Widows 95 and Windows NT environments. A s  a rrue 32-bit application. 

theprogram is not compatible wiilr Wmdows 3 z  It is assumed that the user is familiar with basic operation 
in the Windows 95 environment. For information about Windows 95. the reader is directed to other texts. 

Important benefits and features of the CTPRO Coiled-Tubing Professional Pnckage include: 

increases the speed, accuracy, and user-friendliness of the CT programs 

Reduces CT failures by accurately calculating CT axial loads, normal loads, equivalent stresses, 
circulating pressures along the flow path, bottomhole pressures while tripping, wellbore inclination 
and dogleg, and hook loads at the injector 

. .. . . .., ""-l?;ii:,, 

. ,,. . -. - - .. . Facilitates CT pipe management through comprehensive databases that give immediate access to all 
required CT, equipment, well and fluids data 

. . ... - 
Provides jobspecific inpudoutput interfaces that are easily understood by engineers and field 

. " . , -  ,, 7 - personnel 

.; :.. -...i; . Provides a choice of systems of units, including English, metric or any custom combination 
. .- " -. 

C e ,, . -. Output graphs and tables may be printed, copied to the Clipboard for export into other Windows 
: . , , ?  ,, applications, or stored to disk 

-" .- ... ' ,. 
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Chapter I .  Introduction 

1.3 COPYRIGHT AND DISCLAIMER 

This software and manual are copyrighted (81998) by Maurer Engineering Incorporated. The copyright 
agreement and usage restrictions are described under the Licensing window which is accessed under Help 
-c "About ..." -r "Licensing ..." (see below). By selecting (Accept] at the bottom of this screen, the user 
signifies that he agrees to abide by the restrictions as presented. No warranty or representation, either 
express or implied, is given with respect to the propram and documentation including their quality, 
performance, merchantability, or fitness for a particular purpose. 

'i. : 

*. ,, *>.* - 

CTPro 1.0 
Coiled-Tubing Professional Pa&age 

- Version No. 
1 

D W  
Projedto Develop and Evaluate biled-Tubing and SlimHole Technology I 

By 
Maurer Engineering l n r  

This copyrighted 1998 confidential mmputer program and manual are forthe sole 
use of Partitiparm on Drilling Engineering h a a t i o n  Project DEA47 and their 

.TJsoge affiliaes and are not tn be d i i d  to ather parties Data ouqvt from the 
program may be ditdored to third panics P a M p a n ~  am1 their aRniates are Re*m 
free to make copies of this program and manual (or theu in-house lrre only. I 

1 
Maurer Enqineering Inr makes no warranty or representa$on. either express D i r c h e r  
orimplied;with r 6 e d t n  the program or docurnentalion. induding their qualily, 
performance, merchantabdily, or fitnesfor a parriwlar purpose. 

I International keyboard users - see Appendix A of Userf Manual. I 
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2. Getting Started 

2.1 HARDWARE AND SYSTEM REQUIREMENTS 

CTPRO is written in Microsoft Visual Basic@ version 5. It runs in Miaosoft Windows 95 or Windows NT 
(or iater versions). As a 32-bit application, CTF'RO is not compatible with Windows 3. The minimum 
hardware requirements are: 

IBM-compatible machine with 80486 processor 
Hard disk (about 10 megabytes of storage space required) 
Mouse 
VGA or comparible display 

ZFZ~~STALLING CTPRO 

Program Disks 
-- - .d - 

C -- ." ---- 
CTF'RO is shipped on one CD or multiple 3%inch disks. The CTPRO executable files (CTProDMI.EXE 

CI'ProOMl.exe) should be placed in a special folder (default "C"MEI\CTPROY, or as specified by the 

- h 
er) along with the example data files. All of these procedures will be accomplished during the set-up 

* ?$rocedure described below. -+ , , 

- Baaup  Disks 
---.a 

, -- 
IfCTPRO was received on floppy disks, it is recommended that tk original disks be kept as a backup set and 

-CJ *red in a safe location, and that work disks be made from them. In Windows 95. run Windows Explorer. 

doubleclick "My Computer", single-click the icon for your floppy drive, and select "Copy Dlsk" from the 
F i e  menu. - 

Installation 

The following procedure will install CTPRO from the CD or floppy drive onto the working directory of the 
hard disk (e.g., copy from A: floppy drive onto hard drive directory C:\MEI\CTPRO\). 

1. Choose Run ... &om the Start menu. Then type "D:SETUP" (or "A:SETUP" for floppy disks) 

2. Follow the on-screen insrmaions. 

After set up, a new folder C;MEI Applications") may be created (depending on your choice during 
installation) with the shortcut to CTPRO and other ME1 programs. 

Nore: To move other previously installed ME1 applications into this folder, select Start -+ Settings -c 

Taskbar ... + Start Menu +Programs + Advanced. Then double-click  pro^" to display the folders 
in your Programs menu. Drag and drop shortcuts to other ME1 programs into the ME1 Applications folder. 
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Chapter 2. Gerting Started 

2.3 UNINSTALLING CTPRO 
- - -  - - -  

ShouId it ever be necessary to remove CTPRO from your computer, access the Addmemove Programs 

feature (don't just delete the CTPRO folder). This feature is activated by running Start + Settings -+ 

Control Panel + Add/Remove Programs and seleding CTPRO !?om the list of programs currently installed 
on your computer. 

Using this procedure clears the library registry in the Windows system folder and erases the corresponding 
required library files that are not stored in the CrPRO directory. 

2.4 RUNNING CTPRO 

To launch CTPRO, 
lect it from the ME1 
plications pro-eram 

. group under the 
- ,- 

Pro- Menu (or other 
.., -. 
'. -*--program group you -"""..--- 

&signed during set-up). 
e design and opera- 

of the CTPRO 
Manager are 

.- . . ,. -described in Chapter ;. 

- ,. . , ., 
liput to the Operations 

. Mode1 is described in 
,, - 
'Chapter 4; output win- 

, ^,,-: ' 
---*' dows and features are . 

discussed in Chapter 5. 
For assistance with the 
program, contact ME1 using information presented in Chapter 6. Common problems and solutions are 
described in Appendix A. 

2.5 QUICK TOUR OF CTPRO 

The following quick tour will give the new user a rapid oveniew of the basic structure, features and functions 
of CTPRO version 1. 

Install: 

1. Start Windows 95 
2. Insert CTPRO CD into drive D: (or floppy disk 1 into drive A:) 
3. Choose Run ... from the Start Menu. 

4. Type D:\SETUP and press Enter. Follow the on-screen instructions. 
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- CTPRO Data Manager (see Chapter 3) 

Run: 

5. Launch the CTPRO Data Manager by selecting it from the ME1 Applications folder under Start 
Menu -. Programs. 

Input: 

6. The Roject Editor Window is automatically opened. Select a project from the available options by 

clicking a to th& right of the project box. Data m d s  in each data category are automatically selected 
and their names displayed m each box. 

Edit Database: 
- -? 

7. Open each of the data editors to review and modify the data records from each of the six data types. 
A % -z - .. 1- Select each editor from the Edit menu (string, reel. well, wellsite, fluid. and tool) or by clicking the 

corresponding icon. 
, - - ' ' 

,_..I_ - 8. Click the tabs to review each page of data within each editor. Edit data enkies as desired and save any 
* 

+ .G,,:. changes to the data by clicking the Save button on the fmt  page of the editor. 
, 

" - .. . -. -- ,,,-. 

output: J*. 

9. Print the data record. For example, open the Reel Editor and click the print bunon on the "Select Reel" 
. . ., --,- ., , page. (To select a different printer, change your computer's default printer under Start -. Settings -* 

.A,,;, ;. Printen.) 

10. To close CTPRO Data Manager, click "Exit'? from the File menu or "Exit to Operations Model" to 
automatically load the Operations Model. 

CTPRO Operations Model (see Chapters 4 and 5) 

Run: 

1 1. Launch the CTPRO Operations Model by selecting it from the ME1 Applications folder under Start 
Menu -t Programs. 

Input: 

12. In the Input Window, choose "Open Roj  ect..." from the Eik menu or click 
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13. From the File Open dial- box, select the example project file "OMTestl.OMl", and click OK. (Pleare 
note that pornmedic values in the eamqle project f i  are for ~ X ~ ~ i r a a b n  only and should not be 
considered aspreferred values.) 

14. Click each of the input window tabs (Project, Sawey, CT, Borehole, Formation, Fluid, BHA, and 
General) to review each page of input data. 

15. Select "Start" from the Run menu or click to launch the calculation sequence. 

Output: 

16. After the Output Window is loaded, setect graph windows of interest to enlarge for viewing in more 
detail. Double-click on the graph area to maximize that -@ph to full screen. Double-click again to 
restore the tiled display. 

- ", 
, . .:ZXZ33. Print a graph of interest by selecting "hint" -+ "Output Graph (Active)" from the E ie  menu. 

%. 

.. . . .- . ,, 
tg Maximize the summary table by double clicking on it. Select different data presentations by clicking 

. . radio buttons in the parameter options at the top of the table. 

. Print your selected version of the output table by selecting "Prnt" -+ "Output Table (Active)" from the 

, . File menu. (To select a different printer, change your computer's default printer under Start -+ Settings 
~ ".,.. 

-.-- -.\ 
-+Printers.) 

-._ ~,.*vsL;:. .-;,:,,- - ,. 20. To close CVRO W t i o n s  Model, click "Exit" from the File menu or a in the upper right corner of . .. . ,..,- 
, 6.-- , -.-.... s the main window. 

,..'%Ye$.,. .,. ,, 
la 

- - ~ ,  . 

01 998 Maurer Engineering Inc. 



3. Data Manager 

3.1 INTRODUCTION 

The CTPRO Data Manager allows the engineer and field personnel to select, specify, review and modify all 
equipment to be used on any CT operation. Database groups include: 1) the CT string, 2) the CT reel, 3) the 
well, 4) the wellsite (rig and other equipment), 5) the fluids used for the operation, and 6) the BHA tools. 
Within the Data Manager Main Window, the engineer can browse the file stmcture on his computer (or 

network) and select specific files for viewing, editing, and finally for use in the current job design. .- .- 
Management of complex data for CT operations both in the field and in the office is greatly simplified with 
the user-fiendly CTPRO Data Manager module. Input data are organized by specific type, or records from 
each database type are grouped together and stored as a project. These projects can then & directly accessed 
within the companion Operations Model (see Chapter 4). CTPRO Data Manager data types are listed below. 

,,$=&y*": 

._' , + 

.: ~ 

-. ,? .*%. 
,. . ,- ?- 1. Project documentation (company/clienf well location, job description, etc.) (optional) 

, , .- .. . . . . -., 
&~."--" - - 

2. CT smng geomew, material properties, location of welds, derated sections - - '.,., 
,P.. . .*. "'<,-'. - - - 

" ,.* 
2. Fatigue life history 

4. Wireline geometry (size and weight) 
,,',C13.il: 

-..,- .. 3. CT cost 

6. Reel dimensions 

7. CT dimensions for calculating reel capacity 

Well: 

8. Well description 

9. Directional survey (for example. measured depth versus inclination and azimuth) 

10. Formation pore and fracture pressures 

1 1. Well geometry (IDS and friction factors) 

Wellsite: 

12. Wellsite layout of CT equipment (distance from reel to gooseneck. gooseneck length and radius, and 
distance from injector to zero well depth) 
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Fluids: 

13. Fluid descriptions, rheology model, and mud weight 

Tools: 

14. Tool dimensions 

15. Nozzle sizes andlor total flow area 

Data can be entered and displayed in English or metric units, or a custom combination of English andior 
metric units defined by the user. 

-3.2-* --.- DATA =.- MANAGER MAIN WINDOW 

Zhe Man Window in the Data Manager is the centml platform for viewing and e d i t ~ ~  the CT databases. The 
-- 

most common operation from this window is to open an existing project for editing. Select "Open Project" 
. =,from under the File menu or click Icon. Then select a project from those listed. 3' 

Other basic options from within the Main Window include: 
;>-, .;-: . - 

,-. Creating or opening existing database recork for any of the six data groups (under the B i t  menu 
or the edltor icons 3 a a a @@/) - -- -- - Viewing CT specijiations (under the View menu) 

., . S S ' * A t . . ~  

. ,,; Transferring to the CTPRO Operations Model (see Chapter 4) for performing CT engineering 
analyses of project data created, edited and saved (under the File menu) 

. . _ ?,.'. a , 
".-<*,.r 

. ;*el - ,I 
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@ Menu Bar. Functions of the pulldown menus in the Main Widow are similar to that in other Windows 

applications. A description of all functions and f m  is presented later in this chapter in Section 3.13. 

@ Tool Bar. Tool-bar icons can be used to quickly access commonly used functions. The icons are short- 

cuts for menu options. The functions of the icons are: 

New Project. Clears all input data. 

Open Projecr. Activates the Open Project window. 

Save., Saves all input data to current project name. If the project is new. the Save As ... window 
is activated automatically. 

Prim. Immediately activates a printout of the current window 

* - -"*a&-- 

-- 
String. Opens the String Editor (see Section 3.4) for creating, reviewing, and editing CT string 

C P; 
data records. 

< - -* 

a Reel. Opens the Reel Editor (see Section 3.5) for creating. renewing, and editing CT reel data 
"-7 .**- - records. 

Well. Opens the Well Editor (see Section 3.6) for creating reviewing, and editing well data 
records. 

a 
h 

Wellsite. Opens the Wellsite Editor (see Section 3.7) for creating, reviewing, and editing 
wellsite equipment data records. 

. " Fluid. Opens the Fluid Editor (see Section 3.8) for creating, reviewing, and editing fluid data 
records. 

Tool. Opens the Twl Editor (see Section 3.9) for creating, reviewing, and editing BHA tool 
data records. 

Units. Opens the Units Selection window (see Section 3.1 1). The user can select English, SI, 
or any custom combination of units. 

yip. Opens the Help system for CTPRO direaly to help on the current page. Another option 
1s to select "Help Topics ..." from the Help menu for accessing the table of contents for the Help 
system. 

Calcularor. Activates the Windows utility calculator. 

3.3 PROJECT DATA WINDOW 

Projects are a convenient way of storing and modifying a complete set of data records that will be used for 
a specific field operation (or sequence of similar field operations). The Project Data Window includes two 
pages for organizing project files and data. Each is accessed by clicking on its tab below the icon tool bar. 
Functions and parameters on each screen are described in the sections below. 
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3.3.1 Project File Manager Page 

A specific record for each of the six dab types is selected on the Project File Manaser page. 

-- -,,. L 

,=. - . @ Page T&. Switching between the input pages within a window is simple-just click on the 
. ,. correspondmg tab. 

-- . %, - Project Kame. The name of the current project is l i i  here for reference. Use the open icon a to 

the right of the box to view and select from available projects. 

@ Proje-c~Reconir. The complete project is specified by selecting six (or fewer) project records-one 6% 

one reel, one well, etc. The cun-entfy selected record name is listed in the corresponding box. The open 
icon a to the right of the record name box can be used to quickly open an existing data record for any 

type. 

01998 Maurer Engineering Inc. 



Chapter 3. Data Manager - 
- 3.3.2 Project Information Page 

The Project Information page is used for CT project documentation. 

@ Projed Information. Project documentation can be entered to identify specific companies, customers, 

fields, wells, etc. All of these data are optional. 
. . 
- a 

01 998 Maurer Engineering Inc. 



Chapter 3. Data Manager 

3.4 STRING DATA WINDOW 

In the String Data Window, there are ten different pages for organizing CT string data. Each is accessed by 
clicking on its tab below the icon tool bar. Functions and parameters on each screen are described in this 
section. 

3.4.1 Select String Page 

" e 
9 4 

@ SelectStrhzg Record Available CT string records are listed in the drogdown list box. Any available 

string can be selected by clicking its name inside the drop-do-n list. 

@ Data Lock. String data entered on the other nine pages can be tocked to prevent accidental changes. 

Prior to editing any data within the String Editor, the user must uncheck this box. 

0 record. @ Record Edit Bunons. Edit buttons are used for managing the current strin, 

Save. Saves all string data under the current string name. The string name can be 
changed by typing a new string name in the list box and clicking this Save button (same 
as "Save As ..." function). 

Delete. Deletes the current string record from the database. 

PrinL Prints all CT string data under the current n ing  name. 
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Import Imports a CT stxing iivm an external database specified by the user. A popup 
window is displayed for selecting a database file (*.mdb). 

Export Exports the cment CT string to an external database specified by the user. 

3.4.2 String Sections Page 

The String Sedions page is used to specify the individual tubing sections that comprise the entire CT string. 

- 
_ -@ CTSecrion Data Tubk. This table is used to specify the geomeby and properties of the CT. The data 

entered in the fvst row is the free end of the spool (the dee-pest section m the hole), and other sections 
are entered proceeding toward the core of the spool. The cumulative length of CT is calculated 
automatically and displayed below the table. 

True Taper is an option available From the manufacturer whereby the change in wall thickness along 
a tapered string is distributed evenly throughout the entire section of CT. When a True-Taper section 
is used, specify both Wall 1 (wall thickness at the end closest to the free end of the spool) and Wall 2 
(the end closest to the core of the spool). If the section is not tapered, Wall 2 is filled in automatically. 

CT mated properties can be selected by clicking the material type dropdown list box, which includes 
the most commonly used materials. Properties for other special materials can be typed in manually. 

@ Tubk E& Bumns. The edit buttons for the data table work on complete rows of data. [Insert] piaces 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
whole row is selected. 

@ CT String Schematic. The currently input string sections are displayed graphically for the user's 

reference. 
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3.4.3 Welds Page 

Weld Data Table. Wel,d locations and corresponding reduction factors are entered and edited in this 

table. The weld type can be selected from the dropdom list box. Three options are available: I )  
manual, 2) orbital and ?) heliol/bias. The reduction factor is entered automatically for each weld Srpe 

: selected. The user may change the reduction factor to any other preferred value. 

@ CTString Schematic. A simple schematic of the CT string displays the locations of the welds for the 

user's reference. 
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- 3.4.4 Derated Sections Page 

- 
h -" 

- -- -@ DerutedSeehbns TnMe Any derated sections (mechanical damage, etc.) of the CT seing are specified - here along with the corresponding reduction fictor. Distances are measured from the free end of the CT. 

@ CT-g Sehemutic. A simple S C ~ C  of the CT string displays the locations of the deratd sections - < * ...- . for the user's reference. 
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3.4.5 String Cost Page 

--,@ Cost Data, Total cost for the strirg is calculated automatically based on the CT geometry and the unit 

%---a< 
cost entered by the user. Invoice Number and Actual Cost may be entered by the user. 

: 4 , 6  sf ring Miscellaneous Page 
.,,,,... , 

,,., ,' -. = 
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@ Misccdlmeous Szring D m  Segment Length is the increment used for CT fatigue analysis. The 

default value is 10 ft. The cu~~ently selected reel is shown here for reference (and cannot be changed 
here; go to the Project File Manager page to select anorher reel). A comments box is provided here for 
miscellaneous descriptions and comments on the current CT s&g. 

3.4.7 String Fatigue Life Page 

The life history of the current string is displayed in the String Life page. Fatigue life of the string can also 
be initialized here. 

@ Fatigue Life Grqh.  Consumed fatigue life is dqlayed from the free end of the sfring to the core of the 

spool. 

@ Fatigue Graph Scule. Select or type in the desired full-scale value for the percent life consumed. Then 

click [Redraw] to redraw the graph with the new y-axis scaling. 

@ Inainli~e Life. Click this button to initialize the fatigue life for the current string. (See the section 

below.) 
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Initialize Life Window 

I InirinIl 

the data 

Life Table. The initial fatigue life for each section of the string is entered into the 

starting at the free end of the spool and proceeding toward the core of the spool. 

table. Enter 

- = @ T d l e  Ed2 Buttons. The edit buttons for the data table work on complete rows of data. [Insert] places 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
. whole row is selected. 

, , .,.. =. 

@ Initialize Life ControlBuUons. Click [Initialize Life] after all fatigue data are entered in the table. The 

database will be updated with the new fatigue life data. CIick [Cancel] to discard the data in the table 
and close this window. 
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- 3.4.8 Cable Page 

had 

- - 
--' _ . -@ Cable Data. Check the Cable Installed box if wi rehe  is tnstalled in the CT string. Enter data - 

, describing the cable in the boxes. Cable diameter and weight affect hydraulics and drag calculations. 

- 3.8.9, a& Modify String Page 
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@ Cut String. This h i sdon  is used to remove a section of CT from the current string, or to divide the 

existing string into two separate strings. Clicking [Cut Siring] opens the Cut String Window (see below). 

Cut String Window 

c * i a  - @ Cut Location. Specify the section of CT to be removed, either from one of the ends or from the 

middle of the string 
* .* - --. 

@ Cut Options. Select wfiether the catt section of CT is to be d i i d e d  or saved for future use. If the 

cut piece is to be saved, provide a name and reei for the new string. 

@ Weld d Cut. If the cut is performed in the middle of the cment string, a weld is required to rejoin 

the smng. Select parameters describing the weld. 

@ Splice Siring. This feature on the Modify String page is used to insert a new seaion of CT into the 

current string, either on one end or in the middle. Clicking [Splice String] opens the Splice String 
Window (see below). 
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- Splice String Window 

- - .. J* ., .. ..,"*, 
, " ,  ,..,*. 

: ,,.. ,' 

. @ New String. Select a new CT string from the database that is to be insated into the current string. 

- 
%8 ,?... 

, . 

. . .. , a Splice Location. Specify the location on the current string where the new string will be inserted. 

- 7 n-w..- 
( 

Enter "0" if the new stiing is to added at the free end of the current string. 
- 

@ Weld at Cut. If a splice is performed in the current string, one or two welds are required to rejoin 

the stiing. Select parameters describing the weld(s). 

@ Reverse String. This feature on the Modify String page is used when the £ree end and core end of the 

smng are switched by spooling onto another reel. Clickig [Reverse String] opens the Reverse String 
Window (see below). 
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Reverse String Window 

" ' _ @ New R e e l h e .  Select a new reel from the dropdown list box onto which the string will be spooled. 

If rhe second reel is not on the list, a new reel may be entered directly or imported from another database 
in the Reel Data Widow (Section 5.5). Click [Reverse] to complete the shing reversal onto the new reel. 

Job History f age 

The previous operations performed with the current CT string are summarized for reference on the Job 
History page. 
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@ Job History Table. Operational data related to the field history of the current string are entered and 

edited from the table. 

3.5 REEL DATA WINDOW 
- 

In the Reel Data Window, there are three different pages for organizing CT reel data. Each is accessed by 
clicking on its tab below the icon tool bar. Functions and parameters on each screen are described in this 
section. 

3.5.1 Select Reel Page 

@ Select Reel Record. Available CT reel records are listed in the dropdown list box. Any reel can be 

selected by clicking its name from the list. 

@ Datcl Lock. Reel data entered on the Reel Dimensions page can be locked to prevent accidental changes. 

Prior to editing any data, the user must uncheck this box. 

@ Record Edit Buttons. Edit buttons are used for managing the individual reel data record. 

S a w  Saves ail current reel data under the c m t  reel name. The name can be changed 
by typing a new reel name in the list box and clicking this button (same as "Save As ..." 
funnion). 

DeIde. Deletes the current reel record from the database. 

Pn'n~ Prints all CT reel data under the current reel name. 
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imp or^ Imports a CT reel from an external database specified by the user. A pop-up 
window is displayed for selecting a database file (*.mdb). 

Export Exports the current CT reel to an external database specified by the user. 

3.5.2 Reel Dimensions Page 

@ ReeIDimensions. Enter the reel dimensions and weight. Definitions of required dimensions are shown 

in the reel schematic on the right side of the window. Reel capacity is calculated on the Reel Capacity 
page (next section). 
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- 3.5.3 Reel Capacity Page 

CT Cclpuc@v. Select the CT dimensions for calculating reel capacity. The freeboard dimension is the 

radial height left empty above the outer layer of CT and the reel flange. Freeboard provides room for 

imperfect layers of CT after it is spooled off and respooled in the field. 

9 Reel Capas@ Colcuf in  The calculated reel capacity, and the weight with and without fluid are 

displayed. Click [Calculate] after the data are entered in the upper half of the page to update the 
calculation results. [Print] pnnts the reel capacity results. 
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3-6 WELL DATA WINDOW 

In the Well Data Window, there are five different pages for organizing data describing the well. Each is 
accessed by clicking on i t .  tab below the icon tool bar. Functions and parameters on each screen are 
described in this section. 

3.6.1 Select Well Page 

. , .  , 

@ Select Well Record. Available well records are listed in the dropdown list box. Any well can be 
y" $;.? ..- 

",% .- 't'. selected by clicking its name inside the list. 

@ Record E U  Butions. Edit buttons are used for managing the well record. 

Save Saves all well data under the current well name. The well name can be changed 
by typing a new well name in the list box and clicking this Save button (same as "Save 
As ..." function). 

Delete. Deletes the current well record from the database. 

Print Prints all well data under the current well name. 

ImporL Imports a well from an external database specified by the user. A popup 
window is displayed for selecting a database file (*.mdb). 

W o r L  Exports the current well to an external database specified by the user. 
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- 3.6.2 Location Page 

- '  % " -  _- --- - - - ;- A @ Location D m .  A description of the we11 location serves to document the operation 
* * 

- - --& 

@ Temperaure Dam. Undisturbed temperature gradients should be entered. Temperature can then be 

estimated at any depth based on the surface tem-re and the temperatwe gradient. 

3.6ZSurvey Page 
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@ Survey Duta File. Survey data available within the database are listed in the dropdown box. Click on 

the survey name to pull the data into the project. 

@ Survey Duia Table. Survey data describing the well mjectory can be entered into the table manually, 

by importing from a text file or *.SDI file from another ME1 program, or by pasting from the Windows 
Clipboard. To paste from the Clipboard. arrange the columns in order in Excel, select the data, press 
conwol+C to copy. return to CTF'RO, place the cursor at the top of the a l e ,  and press controltv to paste 
the data into the table. 

@ Table Edif Bunons. The edit buttons for the data table work on complete rows of data. [Insert] places 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
whole row is selected. 

iX.24 . L . V ~  

e..--.. urvey Control Buttons. The function of these buttons is similar to those on the Select Well page 

described above. The principal difference is that importing and exporting survey data is from or to - <* - *.SDl (ME1 standard format) or text files, rather than databases (".mdb). Well surveys can be 
, ., . . , . .. . imported from any style of text fde in which the survey data are arranged in rows. The user can preview - 

the text file and specie which rows contain headings from within a special import window. 
.~ ..,," . .**$*m:3s. ". 
I 

335-4 ,., $~ .. Well Geometry Page 
$ - . - . . 

. ,h  , 

@ Well Geomehy Table. Depth, ID and friction factor are entered for each section of the wellbore. Row I 

starts from the surface. The last row is the bottom of the hole at TD. 

Typical values for friction factor are 0.30-0.40 with water-base muds and 0.20-0.30 with oil-base muds. 
The lower end of the range is appropriate in cased holes; higher values are typical for open-hole sections. 
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- 3.6.5 Formation Page 

*_ 

*.,$Z> 
'., ,.#' 
, -+@ Formarion Data Tabk. Pore and fmclwe pressures are specified at each TVD. The fmt row is 

-. , , - .  
at the surface; the final row is at the bottom of the well. Note that depth is entered as TVD ( m e  

. . . .  depth). 

always 

vertical 
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3.7 WELLSITE DATA WINDOW 

In the Wellsite Data Window of CTPRO, there are two pages for organizing input data. Each is accessed by 
clicking on its tab below the icon tool bar. Functions and parameters on each screen are described below. 

3.7.1 Select Wellsite Page 

..,., -*.,.?. :: @ Select WelLFile Record Available CT wellsite records are listed in the dropdown list box. Any wellsite 
* _ .,>..i can be selected by clicking its name inside the list. 

@ D~lia Lo&. Wellsite data entered on the other page can be locked to prevent accidental changes. Prior 

to editing any data, the user must uncheck this box. 

@ Record Edit Burtons. Edit buttons are used for managing the wellsite data record 

Save Saves all wellsite data under the current wellsite name. The wetlsite name can be 
changed by typing a new wellsite name in the list box and clicking this button (same as 
"Save As ..." function). 

Delete. Deletes the current wellsite record from the database. 

Print Prints all wellsite data under the current wellsite name. 
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Irnpori Imports a wellsite from an external database specified by the user. A popup 
window is displayed for selecting a database file (*.mdb). 

Eqwrt Exports the cwent wellsite to an external database specified by the user. 

3.7.2 Wellsite Dimensions Page 

@ W&e Dimensions. Rig and equipment dimensions required for CT length and fatigue calculations 

are specified on this page. Refer to the schematic on the right half of the page for definitions of the 
parameters. 
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3.8 FLUIDDATAWINDOW 

In the Fluid Data Window of CTF'RO, there are two pages for organizing input data. Each is accessed by 
clicking on its tab below the iwn tool bar. Functions and parameters on each screen are described in the 

sections below. 

3.8.1 Select Fluid Page 

. "  , 

'- ., .,%.(: 
]@ SeZecf FIuidRecord Available CT fluid records are listed in the dropdown list box. Any fluid can be 

~%%.> ,# 

. .. , selected by clicking its name inside the dropdown Iii. 

@ Record E& Bunom. Edit buttons are used for managing the current fluid record. 

Save Saves all fluid data under the current fluid name. The fluid name can be changed 
by typing a new fluid name in the list box and cIicki i  this Save button (same as "Save 
As ..." function). 

Deleie Deletes the current fluid record from the database. 

Prinr Prints ail fluid data under the current fluid name. 

Impori Imports a fluid from an external database specified by the user. A pop-up 
window is displayed for selecting a database file (*.mdb). 

Expo* Exports the current CT fluid to an exqernal database specified by the user. 
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- 3.8.2 Fluid Properties Page 

- rc-. '. 
iil.\ 

,; ,',:;;."+ 

. -L.-,..._ - @ Rheology Mo&k. Select the rheology model that best describes the fluid for the field operation. 

Options include Newtonian, Bingham plastic and power-law. After a model is selected, the 
r % 

corresponding parameter boxes on this page become active. More discussion on rheological models is 
presented in Section 4.3.3. - ". 

@ Rheofogial Consimis Enter the mcmity for Newtonian fluids. For Bin- plastic fluids, enter the 

plastic viscosity (PV) and the yield point UP). For power-law fluids, enter the flow behavior index (N) 
and the consistency index (k). 

@ Mud Weight. Enter the fluid density and any comments pertaining to the current fluid. 
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3.9 TOOL DATA WINDOW 

In the Tool Data Widow of CTPRO, there are three w e s  for organking input data that describes the BHA 
to be run for the current project. Each page is accessed by clicKmg on its tab below the icon tool bar. 
Functions and parameters on each screen are described in the sections which follow. 

3.9.1 Select Tool Page 

' -. . *'? 
,I .?. i, " 

",..'=.*-=*"@ S e k t  T w l  Record Available CT tool records are listed in the drop-down list box. Any tool can be 

selected by clicking its name inside the list. 

@ Daia Lock. Tool data entered on the other pages can be locked to prevent accidental changes. Prior to 

editing any data, the user must uncheck this box. 

@ Record Edit Bumns. Edit buttons are used for managing the tool data record. 

Snve Saves dl tool data under the current tool name. The tool name can be changed by 
typing a new tool name in the list box and clicking this bunon (same as "Save As ..." 
function). 

Delere Deletes the current tool record from the database. 

Print Prints all CT tool data under the current tool name. 
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Import Imports a CT tool from an external database specified by the user. A popup 
window is displayed for selecting a database file (*.mdb). 

w o r t  Exports the current CT tool to an external database specified by the user. 

3.9.2 Tool Geometry Page 

& - - e n  

@ Tool Geometry Tool dimensions and weight are used for engineering calculations (drag, buckling, 

hydraulics, etc.). Manufacturer. Date and Comments are optional entries. 
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3.93 Nozzle Page 

;.,,,. ,.., , '>& =. , 
I 4 '  

No& Area. Effective nozzle area and its impact on hydraulics can be modeled based on either 
-i 

,$ ' * *% 
individual nozzle sizes or total flow area (TFA). If N o d e  Diameter is selected, fill in the nozzle 

. ' diameters in the table below. If TFA is chosen, the TFA box below becomes active. 

.,r. ..-" Discharge Coefficient is a correction factor for the exit velocity through the nozzle. According to 
; , 

..,,' . . ~ - ~ - &  -.., .+ Boqoyne et a]. in Applied Drilling Engineering, 0.95 is a practical limit for this factor. 
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/" 

- 3.10 CT PROPERTIES WINDOW 

The CT Prome. Window provides a convenient and useful reference for viewing properties of particular 
grades and sizes of CT. This window is accessed by selecting "CT Properties" ffom the View menu. 

-_ 
- @ CTSeleajun. Click on the drop-down boxes a to specify CT material, diameter, and wall thickness. 

- Common sizes and grades are readily available. 
, . .-- 

,,,i;i. ,- -,@ CT Properties. CT Properties supplied by the manufacturers are listed for the selected CT grade and , . .,-~w,:.-- 

size. These properties are not editable within this window. 
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3.11 UNITS WINDOW 

The Units window is used to select and edit the system of units for screen displays and printouts. This 
window is accessed by selecting "Uni ts..." from the Utilities menu or by clicking !El 

-- _- 
@ Linh Table Physical parameters and currently assigned units for each quantity are displayed in the 

Units table. The ceb with a yeilow background cannot be edited directly. Allowable options for each 
quantity are accessed by pulling down the dropdown box attached to each quantity. 

@ Custom LinitF Control Buaons If any changes are made to the default English or SI systems of units 

by seleaing another option from one or more of the pulldown boxes, the new custom system will need 
to be saved for b e  use. Use the [Save] button for new custom systems or updates to previously 
created systems. The [Save As ..] button is used when a new combition of units is designed, and the 
user wishes to save it separately, rather than overwritmg the previous custom system Both save buttons 
will cause a save dialog box to pop up. Custom systems of units are stored as *.UNT files. 

The [hint] button will print the Units table for documentation or reference. (This functions only after 
a save.) 

@ Syaern of U& Selection Buttons. Thse  buttons select entire systems of units, which then appear in 

the table. and in all CTPRO windows. The [Other] button will display the file names of the custom 
systems previously created and stored. 

The name of the currently selected system of units is displayed in the upper left comer of the Units 
window ("Default English" in the figure above). 
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@ NIuneric Disphy Format Table The number of decimal digits displayed for each parameter can be set 

by the user. The number of z ~ o e s  after the deciimal point for each quantity will be used as standard for 
the input windows and printouts. 

Within the decimal section of the number (which detines how many decimals are displayed), a zero 
denotes a "hard" digit (always displayed) and a ?#" denotes a "soft" digit (displayed if required). 

@ U& ControI Brutom. These buttons cow01 operations for the entire Units window. [OK] accepts the 

current settings after any changes are made and then returns to the previous meen. [Cancel] ignores any 
changes made since this units screen was a c t i d  and retmm to the previous screen. wndo All] deletes 
all changes made since this units screen was activated, but stays in the Units window for hriher editing. 

ATABASE TOOLS WINDOW 

' The Database Tools Window provides three useful functions for managing the CTPRO databases. 
-. 

Compress Datubuse This function makes a copy of the CTF'RO darabase, - rearranges how the file is stored on disk (that is, compressing it while 
removing superfluous data), and saves the database under the original 
name. Users are encouraged to launch thufunction on aperiodic basis . - - to make the most eficient me of duk resources 

"S ;-",."' . .- 
: ,.- 

Backup Dntnbme Makes a copy of the database under a different name. 

- Users are encouraged to back up the CTPRO database regularly. 
,, 

Repair Dambme This function may repair the database if the program 
quits unexpectedly, for example. if power is lost or a hardware problem 

,,- - ... , . , .. 
.% " 

id develops, 

R a m .  This closes the Database Tools Window and m f e r s  back to the 
previous main or edit window. 

3.13 MENUS IN DATA MANAGER 

The menu system used in CTPRO is similar to other Windows applications. Many functions are self- 
explanatory. There are seven menus in Data Manager: -File, Hi View, Qperations, utilities, Window and 

Help. 
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File Menu 

The File menu contains commands for creating, 
retrieving, and saving CTPRO projects; 
importing/exporting data from external 
databases; printing project data; and exiting the 
program. The functions of the individual menu 
options are: 

1. "New Project" first prompts the user for a 
name for the new project. Select Edit 
Project to select existing database records 
for the new project. Same as .!a 

._ .. ~..Z "Open Project'' opens a dialog box for , ,, - . ..,. 
.. - .- 

exploring the list of available projects in the 
-,* 

" , - -  "' CTPRO database. Same as a 
- , .. 

Save  Project" replaces the previous version -. . &. ,.:. : .& .. - - -.--- of the project with the current modifications. 
No additional prompt is given before 

.--, ,.<<.$ $8 " .- , 
, .-.. overwriting the previous version. Same as 
-. 
., "$'iQ.+ 

, ,, * ,--=I. "Save Project As ..." saves the current version of the project under a different name. A dialog box is 
~ ,.. 
, . . . - - A  opened to let the user specify the drive, directory, and name of the project file. 

.: *- . .  ~ ~ 5 .  "Delete Project" deletes the current project from the CTPRO project list. 

.. . , 
> ' 

6. "Import ..." opens a dialog box for specifying a database from which to import a data record. This feature 
.w, ,*>y .,,, i+ is available only while editing one of the six data records within a project (ming, reel, well, etc.). 
-,, ". .,.: 

7. "Expo rt..." opens a dialog box for specimg a database to which to export the current data record. This 
feature is available only while editing one of the six data records withim a project 

8. "Page Setup ..." provides options for selecting and contmlling the printer. 

9. "Print Project" prints the record names and project documentation data in a summary table. Same as 

10. "Print All" prints all data saved under the current project. 

11. "Exit to CTPRO Operations Model" transfers out of the Data Manager to the Operations Model for 
performing engineering analyses of any CT project. 

12. "Exit" concludes the current session in the Data Manager. CTPRO will prompt for saving the project 
file if data have been changed and not yet saved. 
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- Edit Menu 

The Bit menu is used to access the project and data record windows for viewing 
and modifying the CTPRO database. 

1. "Project Data'' opens the Project Data window (see Seaion 3.3) for 
selecting the six equipment records within the current project. 

2. "String" opens the Seing Data window (see Section 3.4) for selecting, 
viewing and editing the cment CT string data record. 

3 "Red" opens the Reel Data window (see Section j.5) for selecting, viewing 
and editing the current CT reel data record. 

4. "Well" opens the Well Data window (see Seaion 3.6) for selecting, viewing and editing the cument well 

data record. 
- " ~ 

-7: "Wellsite" opens the Wellsite Data window (see Section 3.7) for selecting, viewing and editing the 
s., " current wellsite data record. 
-.1:" " 

i..&z&aAw 6,  "Fluid" opens the Fluid Data window (see Section 3.8) for selecting, viewing and editing the current fluid ,- - ' - - data record. 

.. . .-"-----% . ( "Tool" opens the Tool Data window (see Section 3.9) for selecting, viewing and editing the current tool --- -. - .. data record. - 
. ,, . ,;:> 

- ,  :.- 

- 
iew menu can be used to I) switch odoff the toolbar and status bar 
the Data Manager windows and 2) access the CT Properties window 

1. "Toolbar" toodes onloff the icon toolbar in the Data Manager. The 
icons (see Section 3.2) are available for quickly accessing some of the 
most common menu functions. 

2. "Status Bar" toggles odoff the status bar (battom of the Data Manager window). Turning off the Status 
Bar will provide more room if the complete Data Manager window can't be viewed simultaneously on 
your computer screen. 

3. "CT Ropemes" opens the CT Properties window (see Section 3.10) for selecting and viewing detailed 
performance parameters for a variety of CT p d e s  and sizes. 

4. "CT Life Log'' opens the Fatigue Life page in the String Data window (see Section 3.4.7) for rapid 
review of the fatigue life of the current string. 
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Operations Menu 

The Qperations menu is used to transfer the user out of the Data Manager 
directly to the CTPRO Operations Model (see Chapter 4). The CT operation 
selected from the list of options is sent automatically along with the current 
database project data More operations will be added to this list in later versions 
of CTPRO. The options in this version include: 

1. "CT Loging" for operations without weight on bit; and with additional drag at the BHA 

2. "CT Drilling" for operations with WOB 

3. "CT Tripping" for operations without WOB or additional dmg at the BHA 

4. "CT Packer" for operations applying weight downhole only at a specific depth 

Menu 
.% . . . . 

.. ,-. . , --. .  tie utilities menu contains three useful features for use in the Data 

er. These include: 

nits ..." opens the Units Selection Window (see Section 3.1 1). Same 

. "Database Tools ..." contains three useful functions for compressing, 
, .. 

*,,:a, _ + ,̂  ."<.' 

- 2 backing up, and repairing the current CTPRO database (see Section 3.12). 
~ ~ , ~ .  

,. ii smL- 3.' "Calculator" pops up the Windows calculator for quick calculations. Same as 
. . , .  , 

m 
"indo+ Menu -. 

*- 

The Window menu is used to select the current (active) window among 
any that are open. Note that each secondary window such as Edit 
Project Data, Edit String Data, V i  C T  Properties. and others open 
a new subwindow wide the main Data Manager window After being 
opened, each of these secondary windows may be listed under the 
Window menu and can be immediately reaccessed by selecting it from - 
the list. 

The normal view mode is for rhe current open window of interest to be maximized to full screen. 
Alternatively, the standard Windows 95 options are available. 

1. "Cascade" arranges the graphs and tables in a front to back display with the title block of each graph 
window remaining visible. The program adjusts the size of each open window to occupy the same 
amount of display space. The windows are then stacked starting from the upper Iefi comer of the Output 
Window. Individual plots can be pulled to the top of the stack for viewing by clicking on their title 
blocks or by selecting them from the list in the Window menu. 

2. "Tile Horizontally" displays all open windows simultaneously with a horizontal division between each. 

3. "Tile Vertically' displays all open windows simultaneously with a vertical bar separating each. 
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4.1 REQUIRED INPUT DATA 

Engineering analysis of a wide d e t y  of CT operations both in the field and in the office is greatly simplified 
with the user-fiiendly CTPRO Opemtions Model. Input data are organmd by specific type, or records from 
each database type are grouped together and stored as a project. Data files can be created and saved directly 
within the Operations Model. As another convenient a d m i n i i i v e  alternative, project files created in the 
Data Manager (see Chapter 3) can be opened d i l y  inside the Operations Model for analysis. CTPRO 
Operations Model data requirements are summarized below. 

Project Documentation: 
- , . . ," ,- .. ." , , , - -,,, 

1% Welllproject description (company name, project name, well location, etc.) (optional) 

. - '-,.., 

smrey .Bata: 
_^ TI" , -....--.2-:r - 

2. Directional survey data for the well, including survey station depths, inclinations and azimuths 

t-', ... 1.--.-3. Description of CT string, including OD, wall thickness, weight per unit length, whether the wall thickness 

- 
, i-i* ' 

is tapered, len,& yield strengtb and Young's modulus. If the string consists of multiple sections. these 

.--. . , data are required for each section. 

%E,:&-. 
ta: 

4. ID and friction factor for each section of the wellbore 

5. Pore and fracture pressures (or gradients) for each section of the wellbore 

6. Wellhead pressure 

Fluid Data: 

7. Fluid flow rate and density 

8. aeology model and required parameters (viscosity, yield point, etc.) 

BHAlTool Data: 

9. Bit n o d e  sizes or TFA (total flow area) 

10. BHA length, weight, OD, and ID 

I I .  Drag due to BHA, and set-down weight (WOB) 
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Operations Data: 

12. CT running speed 

13. Safety factor to apply to CT yield load 

14. Pulling capacity of CT injector 

15. Stuffing box drag 

16. ReeI back-tension 

17. OD and weight for wireline inside CT d g  

Data may be entered and displayed in English or metric units, or a custom combination of units defmed by 

the user. 

L4.2 W U T  WINDOW 
- ~. 

. ... . J?,te Input window in the Opztions Model is used to enter and edit dara describing the CT operation. After 
;, -. 

7 e  operation is selected, all required data describing the operation are entered on the eight pages. The 
 calculations are launched by clicking after which the output graphs will be loaded autornaticaily. 

-, ,..--- 

'1. 

+2&roject Page 
r z  ,.i- 

@ Menu Bar. Functions of the pul ldow~ menus in the Main Window are similar to that in other Windows 

applications. A description of all functions and features is presented later in this chapter in Section 4.4. 
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@ Tool Bur. Tool-bar icons can be used to quickly access commonly used functions. The icons are short- 

cuts for menu options. The functions of the icons are: 

New Project. Clears all input data. 

Open Projecz. Activates the open project file window. 

Sy Saves all input data to cwent  file name. If the project is new, the Save A s  ... window is 
- 

act~vated automatically. .- 

EBl Run. Launches the calculations of the predicted CT operations performance. 

Go to Inpuf. Used to return to the Input window for reviewing and modifying input data after 
the calculations are performed. 

.. r~.;ir=:~-ss9 a Go 10 O w .  Used to transfer directiy back to the Output window graphs and tables without 
.--- 

recalculating. Only valid after fmt calculating and then returning to the Input window. 
71- 

-. -.. ". .-" . za Unirs. Opens the Units Selection window (see Section 3.1 1). The user can select English, SI, 

" -T7'*,i-l& 
or any custom combination of units. - -,,-- 

Help. Opens the Help system for CTPRO. Same as [Fl] 
,x,,S$,.:s:"%2: ,, " . 

.- Calculmor. Activates the Widows utility calculator. - - ---..; .., .,. , ;... .. 
+ -' ;:.::''''@ P a p  Tabs. Switching between the five input pages for entering or checking data is simple-just click - - -- -. - - on the correspormd'i tab. The small circle on the left side of each is like a traffic signal. A red 

mi., 
light indicates that data entry is not complete on that page. A green light on all tabs means that all 
required data have been entered and that the calculation sequence may & launched. 

-I_-:. I *<*."- 
: Xote that the tab may not change color until the page is redrawn (by selecting a different tab). 

.:a.A 

@ Project Docummrfafion These data provide specific information about the project to identi@ the 

company, project name, well location, date, and miscellaneous comments. Any or all of these items may 
be let? blank if desired. The function of the progam will not be affected. The maximum string length 
for each entry is 60 characters. 
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4.2.2 Survey Page 

Survey Data T&. Wellbore survey data are entered into the fm three columns of the table. Column 

1 is Measured Depth of the survey point. Column 2 is Inclimflon Angle at that depth. Column Z is 
Ar~muth Angle at that depth. Column 4, TVD ( m e  vertical depth), and column 5, DL (dogleg angle) are 
calculated quantities. The yellow background on these columns denotes they cannot be entered or edited 

% , by the user 
,, .. , 

The user may input up to 600 survey positions in the table. 'The survey depth in row 1 should be 0 feet 
, . 

. , . (or 0 meters). Srwey depths must be in increasing order (i.e., descending down the hole). The measured 
-. . ,. . ;; " depth inclination angle and azimuth angle each have two unit options, independent of the general system 

of units selected for the overall application. 

Enteringmditing Survey Data 

To enter survey data, click on the appropriate box in the spreadsheet table. The most straightforward 
technique for data entty is to t?.pe the number and then press <Enter>. This will automaticafly shift the 
cursor position for the next entry. The order of entry when the <Enter> key is used is: 

[ROW I ]  MD, Inclination, Azimuth; [ROW21 MD, Inclination, Azimuth; [ROW 3] ...... 

Moving Around 

Wlen editing data within the survey table. the arrow keys are the easiest way to navigate. The up!down 
arrow keys are used to move up or down within a single column. The ri&t/left arrow keys are normally 
used when d i g  individual cell vdues. To movefiom column to column, use conirol+righz4q? arrow. 
Do not use the Tab Key; this will move the cursor out of the table to the next button. 
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@ Table Control B u m .  The tabk conk01 keys can be used for edxting the survey table data. [Insert] will 

place a new blank row above the cursor position. [Delete] will clear the current row. A confirmation 
popup box appears before any data are deleted. 

When data enby is complete, the [Calculate] button must be pressed for calculating Columns 4 and 5 in 
the data table. These data will also be used to generate or refresh the survey graph on the right half of 
the screen. 

[Tortuosity] activates the Tortuosity Window (next section) 

@ Dogleg E m  Winning. The dogleg warning feature is provided in ME1 software based on requests from 

our clients. If this feabne is activated, the computer will beep when the dogleg severity ex& the limit 
entered by the user in the box. This alarm can be used for indicating significant errors in inclination or 
azimuth data. Large e m  (which produce large doglegs) will be quickly found and corrected. 

.. - , .xs-2.%*?:"> 

+!@ Survey Graphs. The survey data are plotted graphically in one of three fonnats chosen by the user. 
-. .p. - Options, which include inclination angle with depth, dogleg severity with depth, and a 2D wellbore 

.. ..,% profile, are selected by clicking the radio buttons at the boaom of the graph area. These plots can be very 
n -.-. 

helpful for spotting aron in the survey data. The selected graph can be sent to the printer by selecting 
. .., .; ,, ....< "Print" from the File menu. 

. . % - -  - -  .. - 
h 

4~:bTortuority ,-- Window 
'-..,-I._- & 

The Tortuosity window is accessed from the Survey page of the Input window. 
.s.- . -% 

When planning a well, surveys generated from geometric considerations kck-off point, build rate. well-path 
shape, etc.) are usually smooth c w e s .  Actual wells contain doglegs and other irregularities that increase 
drag. Wlen ideal (smooth) curves are input into a drag model. the model predicts drag values that are lower 
than those in actual wells containing doglegs and other irregularities. 
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Exxon developed a simple and elegant way to modify the survey data so that conditions are more 
representative of real wells. Tortuosity is added to the welip&; tha~ is, a d l - s c a l e  sinusoidal variation with 
a given period (or cycle length) is added to both inciination and azimuth angles. 

The amplitude of the tortuosity (maximum value in degrees of the sine-wave variation) is chosen according 
to hole conditions. ,&on  fomdthut a toltuosiry of T = I "represents rypicalfield condifions. The original 
survey data are then modified (?ortured'? by adding the corresponding dogleg to each survey point. These 
data are exported to the Survey Page and used to predict drag and buckling in a real wellbore. 

@ Survey D m  Tabfe The values initially appearing in this table are copied from the Survey Data Table. 

After tortuosity is added to inclination and azimuth, the adjusted values will appear in this table for 
review. Data cannot be edited within this tabie. Return to the Survey page (click [OK] or [Cancel]) to 
make changes to any survey data The table can be enlarged by using the Widows control buttons a 
and a. 

, ',-#. - '7. ,<" "-  
, , ---* ~ 

@ Torruosi& Zone Purunzefers. The survey can be divided into as many as five zones (for example: 
". - . ."-- surface to KOP, first build section, fust tangent section, second build section, second tangent section...). 

, ., - ." . . , ~ ,  . ( - _  Each survey zone may then be given a different amplitude andlor period for its distributed tortuosity. 
~ .~ The bottom measured depth should always be equal to the maximum survey depth. 

<r %.",. Amplitude is the maximum dogleg added to the data Exxon found that a tortuosity of T = 1 " represents 

\-.~. typical field conditions. .-,,-- . . 
.- .. .c .. ..a' 

../ 
,_*- 

' - - .-.l. _.__- 
The Period is the length of one sine-wave cycle. This value is generally greater than the distance 
between survey data points. Note that, in selecting the tortuosifL.period onepote~ialproblem needs 
to be avo~ded. If the untolhlred survey data are equally spaced and the tortuosity period A is a s s ~ g e d  
a value such that the measured depth of each survey station is nN2 (where n is any integer), then after 

. caiculahon the s w e y  data will remain untortured (the value of the tortuosity sine funct~on wiIl be zero 
- a  

- exactly at every station). Thzi- meam that rhe torruosiryperiodshouId not be arsigned a value that rs 2/n 
(2, I ,  %, '4. ere.) times the dzi-tunce between survey stations. I t  is reeornmended that A be a t  least five 
times greater than the interval between survey stations. 

Insert Survey Stations is used if the survey depths are too widely spaced for a reasonable tortuosity 
period. Click "insert in zone x" to add stations. The default interval bemeen inserted stations is 100 
ft. 

@ Torhros&v Control Butt4m. There are five command buttons at the bottom of the Tortuosity Widow. 

[Calculate] tortures the original survey data, and both the survey data table and dogleg severity gaph 
show the tormred survey. &Jndo] resets the data to the original survey. [ h i t ]  prints the active window. 
(If the table or graph is maximized on the screen and the print command button is hidden, press [F6] to 
print.) [OK] copies the tortured survey data to the Survey Page. [Cancel] closes the Tortuosity Window 
without any changes to the survey data. 

@ Tortured Dogkg Graph. The impact of adding tortuosity to the survey can be visualized by inspecting 

the dogleg graph. The gaph may be enlarged for easier viewing by using the Window oomol buttons a 
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.h - 4.2.4 CT Page 

" yzz :" . ."., .--------, - 
,- "'..";2,.,@ .. CT Sbtrg Dma Toble. This table is used to specify the geometry and properties of the CT string used 

6 ' ,,..' 
9' 
' ''--..-_.__L 

for this operation. The data entered in the first row is the fiee end of the spool (the deepest section in 

C 

' '  the hole), and other sections are entered proceeding toward the core of the spool. The cumulative length 
ci:,ii #:* . : of CT is calculated automatically and displayed below the table. 

"- , 

: True Taper is an option available from the manufacturer whereby a change in wall thickness along a - section of a tapered string is distributed evenly throughout the entire section of CT. When a True-Taper 
section is used, specify both Wall 1 thichess (at the end of the section closest to the free end of the 
spool) and Wall 2 thickness (the end of the section closest to the core of the spool). - 
CT material properties can be selected by clicking the material type dropdown list box, which includes 
the most commonly used materials. Properties for other special materials can be typed in manually. 

@ Table Edit Bultom. The edit buttons for the data table work on complete rows of data. [Insert] places 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
whole row is selected. [Clear] removes all entries fiom the table. 

@ CT String Schemalic. C m t l y  input sbir~g sections are displayed graphically for the user's reference. 

@ CTStrng Prop& Dtmbme. Several pameters can be pulled directly into the CT String Data table 

from an attached database of common CT properties. 
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4.2.5 Borehole Page 

\'..- 
,,<.&".'\. 

,:, , ,",' 

y. --I:.-.- . @ Borehole Geomeby Tab&. Borehole size and friction should be specified for the proposed operation. 
-I\. 

..;,., .: 
Emer rhe shaIlowest section (at the surFace) in thefirst raw. Then procesd deeper in the well to TD. 

.. . ..> -' 

@ Casing Propenfa D d a s e .  A database of casing geomefzy can be accessed for determining casing ID, 
*-, ,-.,,$ , ,  

L""' ,.,: if &own. 
,>*. .--., ," , 

@ Table Eda Bunons. The edit buttons for the data table work on complete rows of data. [Insert] places 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
whole row is selected. [Clear] removes all enhies from the table. 
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/CL 

- 4.2.6 Formation Page 

. .*r2j<8 2%k'w, 
. .-. - - - .*. @ Show Pore and F m  Pressure in Graphs. When pore and fiac pressure limits are of interest, these can 

. " ,*.:- ... 
e , .--- - 
-. .-. -... -1. 

be displayed on the output graphs for verifying that hydraulic pressures stay within these limits. If pore 
and b c  pressure limits are not a concern, unselect this option. The output gaphs will be less crowded . ,.r..zz. and easier to view. 

', . 

iClr 
.@ Pore and Fmcture Data Format. The user chooses whether the pore and fiactme pressures are entered -,-,,6s, ,.' 

in units of pressure drop per unit length @si/4 ppg or kPa/m) or as gauge pressures at each depth. This 
option can be changed before or after data are entered. 

@ Trip and kill Mmgins Trip and kill margins function as safety factors for avoiding e x d i n g  pore or 

fracture limits. Typical values range from about 0.5 to 1.0 ppg above pore pressure or below frac 
pressure (0.026 to 0.052 psiifi or 0.6 to 1.2 Walm). Exact values depend on how accurately formation 
behavior can be predicted. Safety margins will be ploaed in corresponding gaphs as more restrictive 
limits within those defined by pordfrac pressures. 

@ Pore and Frac Gradient Datn Table Up to 100 data points (consimng of TVD, pore pressure and frac 

pressure) may be entered in the data table. Enter the shallowest hole section in the fim row. 

@ Table E& 1Pll1Yon.s The edit buttons for the data table work on complete rows of data. [Insert] places 

a new blank row above the cursor position. [Delete] deletes one entire row, whether a single cell or 
whole row is selected. [Clear] removes all entries from the table. 

@ Pore and Frac Gradient Graph. Depth and gradient data in the Formation Data table are plotted for 

inspection. To print the p p h ,  select "Print Input Data" from the File menu. 
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4.2.7 Fluid Page 

*,. 9 . 
: - ,,_I' , : __@ Flrrid Propenkc. Enter the pump rate and fluid density for the operation. Check "Gas Inside CT String 

" .- ,. . .,"-, .a, for operations (such as logging) when the string is buoyed to decrease effective weight 

Select the rheology model that best describes the fluid for the field operation. Options include 
Newtonian, Bingham plastic and power-law. After a model is selected, the corresponding parameter 

- " bxes  on this page become active. More discussion on rhmlogical models is presented in Section 4.3.3. 
Enter the viscosity for Newtonian fluids. For Bin- plastic fluids, enter the plastic viscosity (PV) and 
the yield point (YP). For power-law fluids. enter the flow behavior index (N) and the consistency 
index (k). 

@ B2 Nodes .  Effective nozzle area and its impact on hydraulics can be modeled based on either 

individual nozzle sizes or total flow area (TFA). If Eozzle Diameter is selected, fill m the nozzle 
diameters in the table below. If TFA is chosen, the TFA box below becomes active. Note that the TFA 
is calculated and displayed as nozzles are input. 

Discharge Coeff~cient is a correction faaor for the exit velocity bough  the nozzle. According to 
Bourgoyne et al. in Applied Drilling Engineering, 0.95 is a practical limit for this factor. 
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>c.B,2.s,z .7:~> 

,__._."I- - - . @ BHA Parume%ers. Miscellaneous parameters related to the operation and the tool nm on the end of the 
,- '.. ,,.,$*.- 

,..', ,,.- 

' 2  ',. ' 
x ' CT are specified here. Text labels on these boxes change to reflect the selected operation. 

-- - _ *  

n 
Depth of Interest defmes the current working depth of the BHA. For logging, packer, and other similar 

.-U1 operations in existing wells, the CT may not need to penetrate to TD as specified in the wellbore survey. 
All output graphs will display results from the surface to the Depth of Interest. 

-"i' . . 
.a@ BHA Sclimdc. An A n t e d  graphic depicting the BHA in the hole is shown to remind the user of the 

currently selected operation. Access the Animation window (under the mferences menu) to turn the 

BHA Animation on or off. Operation type is selected under the Qperation menu. 
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4.2.9 General Page 

A,: z,, .  ,&A' . '- 
- 

.. 
''. .. @ Depth Summary. Total lengths of the hole, CT, and CT-BHA are shown here for reference. These 
(i ,,,. 

> >  .., 
, 

(I' -- -- _,,_ 
quantities may not be edited here. 

, , ,*sA.*-,..@ .A Residual Bending. Coiled tubing is not completely straight as it emerges from the injector. Residual 

bends in the tubing cause buckling to occur at lower axial loads than would be the case for perfectly 

% - straight tubing. The impact of residual bending is simulated in CTPRO by increasing the friction factor 
* ~ when running in the hole. Typical values for increases in friction factor due to this effect range from 

about 0.05-0.10. 

Miska et al. (I 996) at The University of Tulsa reported laboratory results of buckling tests in SPE 37056. 
Effective friction factors for new straight CT and residually bent CT varied by about 0.09. 

@ General Pmmwfers Several general parameters re- to CT field opa t iom are specified here. WeU 

Head Pressure impacts pressure drop and hydraulics calculations. CT Running Speed also impacts 
pressure drop. Input the highest running speed anticipated during the operation. Derating Factor is the 
traditional safety factor for exceeding yield stress. A typical value is 0.80 (80%). 

4.3 SELECTION WINDOWS 

The user can select the specific field operation to be modeled, default buckling models (for sinusoidal and 
helical buckling modes) and the fluid rheology model. These windows are accessed under the Qperation and 
Preferences menus. - 
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- 4.3.1 Operation Model Selection Window 

Select a CT operation from the available options. This selection changes text labels on several parameter 
enlries and deactivates parameters not appropriate for the selected operation. Additional operations will be 
added to this list in later versions of CTPRO. 

.. - -- .-. .-., <:. - 
4kXBBuckJing Model Selection Window 

..*". 
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and buckling predictions are vay  useful for planning CT opeTatim and avoiding problems in the field. 
The compressive loads required to inifiate sirmsoidal and helical buckling are indicated on the graphs output 
of the slack-off plots. The tubing yield limit is also shown. The significance of these sbges of buckling is 

described below. 

Sinusoidal Buckiing 

As compressive force is increased on a length of tubing lymg along the bottom of an inclined hole, a point 
is reached where the tubing will assume a 
sinusoidal configuration (basicaIly a twc- 
dimensional undulation) side to side across the 
bottom of the hole. The axial force required to 
initiate thii fust mode of buckling is calculated 
in CTPRO using one of three models selected 

S Xx-" "=4i 

- - 4 y  the user. Parameters that affect sinusoidal 
buckling load include: 

- 3" " -  

a cross sectional area of tubing 
ie.-- -*%, * * 

A- - Young's modulus of CT 
moment of inertia of tubing cross seaion 

- *a ia- I; 
-A, radial clearance between tubing and 

'-< -. 
" % 

borehole 
m *,,- n tubing density 

-- -.--- . inclination of hole 

- - *  
- .  *Helical Buckling 

7 
,.ifthe compressive load is increased beyond the point where sinusoidal buckling occurs, helical buckling will 

-. .*, . +eventually be initiated. In this buckling mode, the tubing forms a helix (spiral) along the wall of the hole 
(a 3-dimensional shape like a stretched spring). The pitch of the helix decreases as the compressive load 
increases. Helical buckling begins when the axial compressive force is about 1.4 times the value of the 
sinusoidal critical load (based on the assumption of a straight hole). 

Which Buckling Criterion Do I Use? 

As indicated above, the smallest critical force is the compressive load that init& sinusoidal buckling. Next 
is the critical compressive force that shifts the tubing from sinusoidal to helical buckling. Finally, axial load 
increases to the point where the tubing begins to yield. What is the safe upper limit forjob planning? 

Field experience has been reported by several authon and participants in ME1 DEA projects. Newman et al. 
("Safely Exceeding the -Critical Buckling Load' in Highly Deviated Holes," SPE 19229, 1989) and other 
authors indicate that CT can safely be pushed into a hole using compressive loads considerably in excess of 
the sinusoidal buckling limit. In the field cases reported, compressive forces greater than the sinusoidal limit 
have been used to push CT into inclined holes. Because of well geometry, they were not able to test 
compressive forces grater than the helical buckling limit. Many field operations conducted since then have 
verified that compressive forces larger than the helical buckling limit can safely be used to push CT into 
deviated holes. 
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The CT yield criterion is n d l y  significantly higher than the helical buckling limit. This condition is 
closely associated with lock up. After the CT just begins to yield, significant additional force may be placed 
on the s@ing before it fails completely, but little additional p e n d o n  will be achieved. The yield limit with 
an appropriate safety factor is a practical upper bound for tubing forces. The safety factor applied to the yield 
Limit @efattng Factor on the General page) is applied to the output graphs and should be based on practical 
experience. 

Buckling criteria should be used carefully and as guides rather than as absolute indicators. Judgment based 
on experience, though sometimes expensive to acquire, is of great value when dealing with concepts la& - 

buckling and all its implications. Buckling itself does not imply failure, but it indicates the onset of a - 
condition which may precipitate failure. 

Which Buckling Model Do I Use? 
( 7. z.e"-L-z different models for calculating sinusoidai and helical buckling loads are provided in CTPRO. These 

-,include: 
<-,< 

<$I . 
Sinwidal Buckling Helical Buckhg 

, ,.... -~ ",-- . a -.--,.-- - , -- I.  DawsoniPaslay (Exxon) 1. ChenfCheatham (Rice University) 

.._-a..S-ixi: . .. . . 
2. WdJuvkam-Wold (Texas A&M) 2. WufJuvkam-Wold 

., ,-/- - .. -.. 3. HelKillingstad (Rogaland Research) 3. HeiKillingstad 
F- '.%. . 

-.- 
.<" ... ~ s i n ~ l e  model that has been accepted by several authors is used to calculate the load above the helical limit - that begins to yield the CT. 

a historical perspective, the D a d a s l a y  model was developed first and published in 1984. It quickly 
e widely applied. ChdCheatham published their model for helical buckling in 1990. The other 

.... ,,.ifi~odels were developed later (WdJuvkam-Wold and He/KilLin@ were both published in 1993) and sought 
to examine and improve the assumptions and boundary conditions of the earlier models. 

There are two primary areas where these buckling models differ. 

Straight Wellbores 

For straight wellbores (for example, horizontal sections), the primary difference b e e n  the models is the 
nature of the changing axial load in the interval between sinusoidal and helical buckling. The assumption 
made by ChedCheatham is that the axial load b e e n  the development of sinusoidal bucHmg and the onset 
of helical buckling is constant. Since the load does actualiy increase between these two buckling modes, 
ChenICheatham used a constant value that is the average axial load during the helical buckling process. 

Wu/Juvkam-Wold proposed that, rather than the average load, a linearly increasing load should be assumed 
for the helical buckling process. The result of this difference in assumptions is that WdJuvkarn-Wold 
predicts a helical buckling load that is about 30% higher than ChentCheatham. Again, note that this applies 
for migh t  sections. 

The sinusoidal buckling load in a straight hole section is the same for all three models in CTPRO. 
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Curved Wellbores 

Buckling criteria in curved wellbore sections can be significantly different depending on the model selected. 
Tubing that is constrained in a curved wellbore is already bowed and will be supported against the bottom 

side of the w e .  Much greater axial loads are required in this case to force the tubing to lift off the bottom 
of the hole and buckle. Dawson/Paslay and CheniCheatham do not consider the impact of curvarure on the 
development of buckling. 

WdJuvkam-Wold and HKdlingstad both consider the impact of wellbore curvature. Their analysis and 
experiments showed that, the larger the build rate, the larger the load to initiate buckling in curved wellbores 
with increasing inclination. WdJuvkam-Wold also model the increasing axial load between sinusoidal and 
helical buckling in curved wellbores, and consider the difference in length of the inner and outer curve of the 
casing. HeKillingstad assume a constant load (as did ChenICheatharn) and ignore the length difference. 

- - .-.~4Eomparison of Models 

* ! h e  to the differences in these assumptions of axial loads and buckling in curved wellbores, the buckling 
Godels in CTPRO can produce different results. This is especially m e  for helical buckling in curved sections 
th increasing inclination (going to horizontal, etc.). Generally, ChedCheatham willproduce the lowest 

r comernative) helical buckling load criterion, HeKiillngstad a higher load, and WJJmkam- Wold the 
r. In engineering analyses of this type, the engineer often tends to choose the most consenative model. 

owever, since the constraining effect of a curved wellbore can be very significant, it is most probable that 
Chen/Cheatham is too conservative in these instances; that is. the string can be subjected to much higher 

----.-&ads without buckling helically. 

43.3 ,Muid Rheology Window 

" 3%e Fluid Rheology window is used to set the default fluid rheology displayed on the Fluids page (see Section - -- 
4.2.7). Note that the fluid model can also be changed from the default setting while on the Fluids page. 

Three basic fluid models are provided in CTPRO. These include: 

1. Newtonian. These are fluids in which shear stress is directly proportional to shear rate. Examples 
of Newtonian fluids are water. air, nitrogen. glycerin, and light oil. A single parameter, viscosity, 
characterizes these fluids. 
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Most drilling fluids are non-Newtonian, with shear stress not directly proportional to shear rate. Fluids are 
shear thinning when they have less viscosity at higher shear rates than at lower shear rates. 

2. Bingham Plastic. This is the most common rheological model for drilling fluids. These fluids have 
a linear shear-stress/shear-rate ratio once a threshold shear sfress is exceeded. Two parameters, 
plastic viscosity and yield p i n &  are used to characterize these fluids. Becaw these constants are 
determined between the specified shear rates of 500 to 1 OOO sec-', this model characterizes fluids 
in the higher shear-rate range. 

3. Power Law. This model applies to shear-thinning or pseudoplastic drilling fluids. Shear stress 

versus shear rate is a straight line when plotted on a logflog scale. Two constants, n and K, are 
determined from data at any two speeds. 

4.4 -- MENUS IN OPERATIONS MODEL 
-' 

a e  menu system used in CTPRO is similar to other Windows applications. Many functions are self- - .- 
explanatoty. There are six menus in the Opmtions Model: @, Qperation, Preferences, Bun, utilities, 

- - - ---&findow and Help. 

.- 
," -.::,..-%e File menu contains commands for crearin& retrieving, 
-:-----& saving CTPRO projects; importindexporting data 

,*.A,&%,," 
from databases crea,ted within the Data Manager (see 

.<, ' G b t e r  3); and exiting the p r o w .  The functions of the . > 

individual menu options are: 
<_"_ 

..>A,.' 

:.. .. .....- 21. "New Project" fm prompts the user for a name for 

the new project. Select Edit Project to select existing 
database records for the new project. Same as a 

2. "Open Project" opens a dialog box for exploring the 
list of available projects in the CTF'RO database. 
Same as 

3. "Save Project" replaces the previous version of the 
project with the current modifications. No additional prompt is given before overwriting the previous 
version. Same as B 

4. "Save Project As ..." saves the current version of the project under a different name. A dialog box is 
opened to let the user specify the drive, directory, and name of the project file. 

5. ''(=TPRO Databad is used to access and save projects from the CTPRO database. These projects can 
be created and edited from within the Data Manager (see Chapter 3). 

6 .  "Survey File (SDI)" is used to open survey data files created by other ME1 software in the standard *.SDI 
format. In addition, survey dm entered into CTPRO can be saved in *.SDI format for use in other ME1 
programs. 
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7. "Print" prints the record names and project documentation data in a summary table. Same as s 
8. "Exit to CTPRO Data Manager' closes the Opmtions Model and immediately loads the Data Manager 

(see Chapter 3) for editing the CTPRO databases. 

9. "Exit" concludes the current session in the Operations Model. CTPRO will prompt for saving the project 
file if data have been changed and not yet saved. 

Operation Menu I 
"Selection ..." opens the Operation Model Selection window (see Section 4.3.1) for I 
selecting the CT field operation to be modeled. 

Preferences Menu 

e preferences menu is used to set several default values for buckling models, 

#*V A- 

;tieology models, and program operation. 

- "Buckling Model ..." opens the Buckling Model Selection window (see 
" - 2  C: - 

Section 4.3.2) for selecting the default models for CT buckling and lock-up 

- _** - criteria. 
- - -  

2. "Rheolog Model ..." opens the Fluid Rheology window (see Section 4.3.3) for selecting the default fluid .. 
r h o l o g  model. 

- 
3. '-Animation ... opens the Animation options window for activahng or deactivating the animated graphics 

in the lnput window (on the Borehole and Operation pages). When the animation is active, computer 
response will be slowed on some machines. Turn this feature off if computer response is impacted. 

I 

~ h T % e n u  

The Run menu is used to launch the calculations. Click "Start'' to calculate CT 
operations mcdel results and load the main Output window with graphs and tables. Same 

Utilities Menu 

The mities menu contains three useful features for use in the Data 
Manager. These include: 

1. "Uni ts..." opens the Units Selection window (see Section 3.1 1). 

2. "Sbffs Ellipse ..." displays a am ellipse summarizing the eiaxial and biaxial stress conditions for each 
section of the CT string. See Section 5.3.1. 

3. "Pump Equipment ..." opens a window for calculating pump power requirements taking CT string 
geometry into accounr. See Section 5.3.2. 
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? - Window Menu 

The Window menu is used to select the current (active) window among 
those open. After being opened, each of the secondary windows will be 

listed under the W i d o w  menu and can be immediately reaccessed by 
selecting it from the list. 

The normal view mode is for the current open window of interest to be 
. . 

maxmmd to full screen. Alternatively, the standard Windows 95 options 
are available. 

1. "Cascade" arranges the graphs and tables in a front to back display with the Mle block of each graph 
window remaining visible. The program adjusts the size of each open window to occupy the same 
amount of display space. The windows are then stacked starting from the upper left corner of the Output 

_.. . . -...,._-,.,, * Window. Individual plots can be pulled to the top of the stack for viewing by cIicking on their title - block or by selecting them from the list in the W i d o w  menu. 

---- , - Z, "Tile" displays all open output graphs and tables simultaneously in a tiled format. 

- ma:'Tz=i53:' .---- "All Graphs" displays all open windows simultaneously with a vertical bar separating each. 

st21,,zs,6 4. uInput'' displays the main Input window. See Section 4.2. 
..-. 

- 5 .  "Output" displays the main Ourput window. See Section 5.2. 

I .- " '". 

. B e  Eelp menu provides assistance for runnjng CTPRO and presents various 

,parameters describing the user's computer. 
" - 

- * -  

.--*>. 1. "Help Topics ..." launches the CTPRO Help system from the Table of 

Contents. Alternatively, clicking IF.] or opens the Help system a 
directly on a description of the current screen. 

2. ''Assistance...'' opens a popup box which displays MEI's address, phone 
number, e-mail address and other information. Use these contacts to 
obtain additional help with CTPRO. 

3. "About ..." opens the About popup box, which displays the version number of CTPRO along with 
hardware in the user's computer. Click "Licensing ..." to view a summary of the restrictions for 
copying the program and manual, and the program disclaimer. 

4. "Feedback ..." opens a special screen form for documenting specific bugs, problems, etc. and 
communicating with MEI. The form can be printed for faxing or saved to disk and anached to an e-mail 
routed to rUEI@maureng.com 
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4.5 ERROR DETECTION FOR INPUT DATA 

CTPRO includes basic routines for detecting missing data and obvious e m  in the input data. These routines 
are run as soon as the Run command is activated (under the Bun menu or icon). When input data are a 
outside the boundaries and/or appropriate range of values, the error-checkmg routines will detect the error. 
The p r o m  will halt calculation, display an error message describing the problem, and alIow the user to go 
back and correct the data 

" "  - _ Obviously, CTPRO is not capable of detecting small errors m the input data (i.e., when the incorrect 
- - - - -@ramete~s represent solutions that are physically reasonable), but the error checks will help prevent sunple 

3 9 i n g  mistakes from having an enormous impact on the results. 
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5.1 INTRODUCTION 

A comprehensive array of output data is generated by CTPRO for evaluating CT field operations. Output 
presentations include eight x-y graphs and a table whose column layout is selectable by the user. The format 
of the printouts is very concise and informative. After being customized by the addition of your company's - 
logo. the printouts are ready for inserting into proposals, reports. etc. 

- - 

5.2 MAIN OUTPUT WINDOW 

The Main Output window of CTPRO is loaded automatically after the calculation sequence is completed 
- ----within the lnput window (by clicking . Resuits of CT load. buckling and hydraulics analyses are 

presented in a variety of useful graphs, as well as in a table that can be tailored by the user. Options are 
- - -- provided to view the graphs individually or in groups, to easily customize the output for specific applications, 

xm ocument the results in professional-style printouts, to copy data to the Clipbard for importing into Word, - 
"----WordPerfect, Excel. PowerPoint, e?c , as well as several other convenient features. Screens accessible within 

--&e Output window of CTPRO and all corresponding functions are described in the following sect~ons. - -_--- " . - - 
52&0utput Graphs and Tabla 

r * 
,, 

-: 

' Eau~valeasben Hook 

@ Menu Bar. The pull-down menus in CTF'RO are used to arrange output presentation, export data, and 

for several other useful functions. A description of functions and features of the ouput menus is 
presented in Section 4.4. 
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@ Tool Bar. Tool-bar icons can be used to quickly acoess commonly used functions frorn the menus. The 

functions of CTPRO icons are: 

New Project. Clears all input data. 

Open Project. Activates the open project file window. 

Saves all input data to current file name. If the project is new, the Save As ... window is 
activated automaticaliy. 

Run. Launches the calculations of CT operations performance. 

GO to It3puf. Used to return to the Input window for reviewing and modifying input data after 
the calculations are performed. (See Chapter 4.) 

Go to Oupir. Used to transfer directly back to the Output window graphs and tables without 
- * - L - - -- recalculating. Only valid after first calculating and then returning to the Input window. 

-" UniLF Opens the Units Selection window (see Section 3. l I ) .  The user can select English, SI, - ,M * -  
or any custom combination of units. (The Units window IS not accessible from within the 

- - -  " &zmcc - - - -- Output window; return to the Input window fm, since a change in units requires a new 
calculation.) 

- - "LC.**& __ --- Help. Opens the Help system for CTPRO keyed to the current window. Same as [Fl]. 

- Caiculator. Activates the Windows utility calculator. 
- -  

-- @ Graph and Table Windows. The output fiom CTPRO is presented for evaluation in nine tiled windows. 
" .  - These include: 
. ~ - " 1. ArialLoad Distribution (Skrck Om. This is a snapshot of loads across the sfring when the BHA - * 

is at the depth of interest and slack-off (compression) loads are bemg applied. The maximum depth 
(the depth of interest) is set by the user on the BHA page in the Lnput window. Buckling conditions 
are easily v i s u a l d  by noting sections of the sbing where the axial load crosses over (to the left of) 
the buckling limit curves. 

2 .  AnWLoadDktribution (Pick Up). This is a snapshot of loads across the string when the BHA is 
at the depth of interest and pick-up (tension) loads are being applied. The exact condition shown 
is when the WOB just fails to zero. (Note that buckling cannot occur when the string is in tension.) 

3. Normal Force Dirtribwion. Normal forces (the components of compression, tension andlor gravity 
forces that push the string against the side of the wellbore) are plotted as a snapshot when the BHA 
is at the depth of interest. Traces for both slack off (the BHA has just arrived at the target depth with 
the required WOB) and pick up (at the point when the WOB just falls to zero) are plotted together. 

4. Hook Load a! Injector. This graph shows predicted pushipull loads at the bottom of the injector 
(above the stuffing box) throughout the planned operation. Results can be quickly evaluated to 
determine whether loads during the planned operation are near limits of the equipment. Unlike the 
snapshot views in Graphs 1.2, and 3, Graph 4 is a dynamic view of the variation in load at a single 
position (below the injector) as the CT is run in and out of the hole. 
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5. Dog& and Inclinnrion Angle. The wellbore survey is summarized with plots of both inclination 
angle (degees from vertical orientation) and dogleg angle (local rate of change of inclination). 

6. Cuadafkg Pmsure Distribution This is a snapshot of hydraulic p-es inside and outside the 
CT string when the BHA is at the depth of interest. 

7. Equiwht  sb.ess Distri6ution This is a snapsbt of axial and equivalent stress along the CT shing 
when the BHA is at the depth of interest Eqwvalent sb-css is impacted by axial load, bending load, 
and hydraulic pressure. 

8. Bottom-Hole Pressure for Slack Ofl?Pick Up. This is a dynamic view of pressure immediately 
below the BHA as the CT suing is run in and pulled out of the well. For some cases, the pressure 
for running in and pulling out is almost the same; consequently, the blue w e  for pick up may not 
be visible. 

9. T a b u W  Reds. All axial I& buckling, nonnal force, and hydraulic results are summarized in 
the table. Column options include I) measured depth, 2) vertical depth, 5) inclination, 4) azimuth, 
5) dogleg angle, 6) axial load (pick up), 7) axial load (slack off), 8) normal luad (pick up), 9) nonnal 
load (slack off), 10) hook load (pick up), I 1) hook load (slack off), 12) sinusoidal buckling limif 
13) helical buckling lh i f  14) hydraulic pressure (inside CT), 15) hydraulic pressure (outside CT), 

16) bottom-hole pressure (pick up), 17) bottom-hole pressure (slack off), 18) axial stress, and 19) 
equivalent mess. 

The user selects which columns are displayed in the table according to a specific parameter (click 
"By Parameter") or by a related groups of parameters (click "By Group"). 

@ Window Conrrol Buitons. The standard Windows 95 control buttons are useful for maximizing and 

minimizing individual graphs for rapid review and evaluation of results. The a button will enlarge a 

tiled graph or table to occupy the full screen. The button will minimize a p p h  or plot (i.e., convert a 
it to an icon at the bottom of rhe screen) To reactivate a minimized plot. press to replace the gaph a 
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a BZl into the tiled screen or to zoom the graph to full screen. The button will temporarity turn off 

a graph; however, a closed graph is turned off only for the current run and will be redrawn the next time 

a calculation is completed. 

Note: Another convenient featrrre was added for rapidly reviewing the graphs. ~~ in the tiled display 
format, doable-click anywhere on a graph to maximize it. Review the plot and double~lick again 
to restore the tiled display. 

5.2.2 Output Window Menus 

The menu system used in CTPRO is similar to other Windows applications. Many functions are self- 
explanatory. There are seven menus in the Operations Model: F i  Qpention, Preferences, Bun, Utilities, 
Window and Help. See Section 4.4 for a complete description of the menu structure and functions. - 

3 . --- ySSCONDARY OUTPUT WINDOWS 

Stress Analysis Window 

--.:*'he CT Seess Analysis window is used to evaluate biaxiai and API stress for each section of the CT string. __ -4-- 

, This window is accessed by selecting ''Skzss Ellipse ..." from the Utilities menu. This feature is available 
" >only after a calculation has been completed. - *a- 

---XI - 

@ CT Stress Groph. Biaxial and API stress limits are shown for the currently selected section of CT. 

These limits reflect the operational safety factor specified by the user (CT Derating Factor on the 
General page). The upper right quadrant of the graph corresponds to a combination tensionburst- 
pressure environment, the lower right quadrant to a tensionicollapse-pressure environment the lower Ieft 
quadrant to a compressiodcollapse-pressure environment, and the upper left quadrant to a 
compressionburst-pressure environment. ?he s&ess for each section of the h g  (shown as  the blue line 
near the center of the plot) should remain inside the boundaries defined by the seess-limit curve. 
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'Ihe upper half of the plot is based on z m  external pressure and the lower half on zero internal pressure. 
The pressure diierence based on the hydraulics calculations in the output graphs is used for these results. 

@ String Section Selection. Select the specific section of the CT string plotted on the graph. These 

sections correspond to those entered on the CT String Data table on the CT page in the Input window. 

@ CT Parametem. These CT dimensions and material properties are presented for reference for the 

cuITently selected CT section and may not be edited within this window. Changes are made on the CT 
page in the lnput window. 

5.3.2 Pump Equipment Window 

The pump equipment window is used to calculate pressure loss in the CT on the reel and estimate output 
.- #= =pressure and hydraulic horsepower requirements for the fluid pump. This window is accessed by selecting -- 

''Rrmp Equipmmt" from the Y t i l i i  menu This feature IS available only after a calculation sequence has 
* 

. -- .- &n completed 

@ Pump Equijmem Inpuf Data. Type in the required parameters describing the flow system. The fluid 

model cannot be changed here. Model selection is performed on the Fluid page in the lnput window. 
After all parameters are entered, click [Calculate]. 

@ Pump Equipmcnf Outpuf DmP. Pressure loss, pump pressure, and hydraulic horsepower requirements 

are shown in these boxes after a calculation. (These are not edi i le . )  

@ Pump Eguipmeni C o ~ I B i l & m s .  Click [Calculate] after the input data are entered. IRetum] closes 

this pump window and returns to the Main Output window. 
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6. Getting Help 

6.1 CONTACTING ME1 

For additional assistance with installation or operation of CTPRO, contact: 

Dr. Xichang Zhang (Data Mmager) 
or 

Lee Chu (Operhns Model) 
~ ~ A I ~ R E R  E N C I N E E ~ C  INC. 

2916 West T.C. Jester Boulevard 
Houston, Texas 77018-7098 U.S.A. 

Telephone: (713) 683-8227 
Fax: (713) 683-6418 
1 

.. - . . .".,-em.=,.'* 
a "-- 

6.2 REPORTING PROBLEMS 
.--,'..L.:A- _- -. - 

F . . ... Even though CTPRO has been carefully checked before its release, software bugs are a fact of life. Please 
$ 5,". 

- , report to us any bugs you find and describe the input parameters and conditions seieaed when the bug _ 
occurred. 

m " '%&I is also very appreciative of your comments and suggestions for improving CTPRO. Let us know if there 
are additional features you would like to see added to the program. Though it may not be feasible to 

n. incorporate e v q  suggestion into the next version, many important improvements have been made to this and - other ME1 programs based directly on suggestions from users. 

Please use the form on the next page to report bugs in the program, as well as sugestions on improving the 
function and usefulness of CTPRO. 
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Bug Report/Enhancement Suggestion Form 
- 

Name: Company: 
Address: City: State: 
Phone No.: Fax No.: 
E-mail: Date: 

BuglRoblem Report 0 Enhancement Suggestion 

Program Name and Version Number: 

BugProblem Description or Suggested Enhancement: 

- h 
Other Comments: 

DatalPanlmeten Causing Bug 
Will be mailed on diskette [7 Will be faxed 0 Attached None 

O ~ e r a t i n ~  Svstem 
MS-DOS Version No.: MS-Windows Version No.: (Win 3.1TWin 95) 
OS2 MS-Windows NT Version No.: 
Other 

Please mail fax, or e-mail to: 
[: 

Lee Chu 
;i MAURER EKGINEERISG INC. 

2916 West T.C. Jester 5 
Houston, TX 77018-7098 

Ph: 7131683-8227 Fax: 713f683-6418 
E-mail: rnei@maureng.com 

I 
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Appendix A - Common Problems and Solutions 

Specific problems related to installing and running ME1 software are described in this section. These 
problems have been reported by multiple users and are often related to computer settings and file locations. 

A.l INTERNATIONAL KEYBOARD SETTINGS 

"Type Mismatchn Error 

All computer software developed at Maurer Engineering Inc. is written using the U.S. Keyboard format. 
Under this numeric standard, the 1000 v t o r  is a comma, and the decimal separator is a period. Thus, the 
number one thousand, two hundred and thirty-four and PllOO is written as 

- ----Numbas input into ME1 programs are stored in this format 

koblems have occurred for some of our clients who use the International Keyboard format, as is common 
in'certain countries in Europe and South America. Here, the same number would be written 

. ~ . - -. - ,, . 
1.2343 

.,.., "., 
.,,, . ... ..&here the 1000 separator is a period, and the decimal separator is a comma. - 

A - Ysers with the IntemationaI Kqboard format find that their computers garble input data being loaded into 
+ ME1 programs. Often. a "Type Mismatch" error halts the program. - - - -"- - This problem can be readily solved by changing the Windows numbers format from International to U.S. 

format. This can be accomplished as follows: 

1. Select the "Control Panel" icon h m  the Maim menu seen. This is done by pointing the mouse to this 
iwn and double clicking. This brings up the "Control Panel" menu screen, as shown below. 
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2. Select the "International" icon from this menu screen by pointing to it with the mouse and double 
clicking. This brings up the International Menu screen. 

3. In the lower right comer of the "International" menu screen is the "Number Format." If the number 

under the words 'Wumber Format" is 1,234.22, ME1 programs should run successfully. Click <Cancel> 
to back out of this screen. 

If the number under the words "Number Format" is 1.23492, it must be changed before ME1 progams 
will run successfully. 

4. To change the number forrnat, click on the "Change" button in the "Number Format" box on the screen. 
This will bring up the "International-Number Format" screen. Change the "1000 Sepmor"  from a 
decimal to a comma. Nexq highlight the "Decimal Separator" box and erase the comma from the box 
and replace it with a period. 

5.  Click <OK> to exit the "International -Number Format" box. Click <OK> to retum to the Main menu 

screen. 

In Windows 95 

- - - 1.  Select "Settingsn+ "Control Panel" from under the Start menu. This brings up the "Control PaneT' 
- --- menu saeen, as shown below. 

2. Double-click the "Regional Settings" icon. 

3. The simplest method to change the number format is to select "English (United States)" from the drop- 
down list on the "Regional Senings" page. Thii changes all conventions to U.S. format. To change only 
the number format, click on the "Number" tab and change the Decimal symbol to "." and the Diiit 
grouping symbol to -,". You may have to restart your computer for these changes to take effect. 
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- A.2 POTENTIAL LIBRARY FILE PROBLEMS 
A 

Most of Maurer Engineering's computer programs are MS Windows-based programs which run under 
Windows 3.q Windows 95, and Windows NT operating systems. When our Windows programs are run, 
several libmy files are needed (.VBX, .OCX, DLL, and .W;) to support the Windows interface functio~~~. 
These library files might also be used by other Windows programs, which means all types of Windows 
applications theoretically can share the same Iibmy file from a "common library." 

The basic concept of a common liirary is sound. Since one library file may support many programs, storing 
the library once in an accessible location saves space on the hard drive. However, because of compatibility 
issues with different versions of the same libmy files, the wrong library version can cause a program w- - 
Progamr developed/compiled with older versions of library files may not run with newer versions or vice 

- 
vem. 

When running a Widows application, Windows searches for required library files in the following sequer~ce: 

1. the \Wiidows\System\ subdirectory 
-2. the \Windows\ subdirectory - - 
3. the local program subdirectory which contains the executable application .EXE file 

These rules were established by Microsoft an4 unfortunately, may lead to serious problems. Placing the 

- wrong version of the common library into \WindowslSystem\ subdirectory will cause all programs which -- 
use a different ~version of that library file(~) to malfunction. Maurer Engineering has received many reports 

= - oEproblems - with our software after users have installed anotber company's software. These problems are - - - the result of the thud party software ind l ing  its own (different) vmlon of the library into the 
\WindowslSystem\ subdirectory. This new venlon then gets priority over the correct version in the local 

- ME1 subdirectory. 

All ME1 Windows programs install the required library into the local program subdirectory to avoid conflict 
with other programs already installed. T h o u  this method requires slightly more dlsk space be reserved for 
libraries, this is the safest approach. If this procedure is followed, users should not be apprehensive about 
installing MEI's progams. 

If a user finds that an ME1 program will not run or the output graphs will not display, the following procedure 
should solve any library incompatibility problems. 

1. Most of the time, MEl's programs will display an error message to indicate which library files are 
incompatible. If so, go to Step 4. 

2. Look at the specific progam's s ubdkctory to find all the library files needed by the program. Usually, 
the library file extensions are .VBX, .OCX, .DLL. .EXE. 

3. Check the \WidowslSystem\ and \Windows\ subdirectories to see if there is a different version of the 
libmy file (different size or different date) stored there. 

4. Move these library files from the \Windows\System\ or \Windows\ subdirectories to a temporary 
subdirectory (do not erase these files) to determine whether library incompatibility is the problem. If 
these files are used by another (non-MEI) program, copy these files to the other program's subdirectory. 

The following library files most frequently cause problems: GRAPH-VBX, GSWDLL.DLL, GSW.EXE, 
GSWAGldDLL, GSWldEXE, VBDB300.DLL, THREED.VBX, and GRID.VBX. 

If the problems persists after these steps are taken, please contact MEI. 
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A.3 PRINTER SELECTION 

MJ3 programs mpprt a wide range of monochrome and color printers. However, most programs written in 
Visual Basic 3 (16-bit) do not provide options within the program for selecting individual printas. All print 
jobs are sent to the cment Wmdows default printer. 

Changing Printers 

If you wish to switch to a special printer, assign that printer as the Widows default printer before 
running the ME1 program. The defautt printer is selected under the Printas confro1 window. window 
is accessed in Wmdows 95 by selecting Start --• "Settings" + "Printers". ARer the Printers window is open, 
click once on the printer of interest to highlight it. Then, select "Set as DefauIt" from the File menu. 

Network Printers 

;. -. ,,-.:.,.Some users have experienced problems when trying to send output from ME1 software to network printers. 
. , . 

Most difficulties can be addressed by modifying the printer port entry. If a network printer will not print &om 
'& ME1 program, follow these steps: . , .,, , 

. --  "- 1, Select Start + "Settings" -+ "Printers"; then double-click the network printer icon. 

2. Select "Properties" from the _Printer menu. Select the "DetaiY tab from the Properties window (see 
,,, .,. ' . ---. figure). 

-3. Place the cursor on the entry in the text box under Print to the foUowing port:. Copy the text string by 
~ressinz control-C. - 
Click the "Capture Printer Po rt..." button. 

Select "LPT2" or "LFT3" under the Device 
pull-down menu. 

Click the Path: text box; then paste the text 

ming into the box by pressing control+ V. 
Click <OK> to close the "Capture Printer 
Port" window. 

On the "Details" window, pdl  down the list 

of options under the Print to the following 
port: box. Select the new entry (that you 
just created) with "LPTZ" or -'LPT3" 
followed by the text string copied and 
pasted. 

Select <OK> and close all printer windows. 

This procedure should allow printing to a 
network printer, provided that printer is 
also selected as the Windows default 
printer 
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